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Introduction

RIT employees are able to upload transactions into the Oracle Financial applications from Excel, and publish financial information for their departments and projects from the Oracle Financial Applications into Excel. 
Objectives:

After taking this course, you will understand the process to follow when creating journal entries in Excel, performing on-line account inquiries, drilldowns, requesting reports to be published into Excel, store FSG reports and run multiple reports at one time repeatedly.  You will be able to use the general ledger to:

· Create a journal entry in Excel and upload it into the general ledger.

· Perform an on-line account analysis, and export it to Excel.
· Drilldown to journal entry, accounts payable or accounts receivable subledger detail.
· Create a Request Set.
Advantages of the Advanced Functionality of the Oracle Financial Applications
Using the advanced functionality within the Oracle Financial Applications provides many benefits to you such as:

· Quickly creating journal entries with large numbers of lines using Excel functionality.
· Use the same journal entry template repeatedly to upload recurring journal entries. 
· No manually entering each journal entry line into the journal entry form in Oracle.
· Export transaction detail into Excel rather than downloading and formatting.
· Run multiple reports at one time repeatedly using a Request Set.
Accounting Procedures

Department and project managers or staff assistants monitor their actual expenditures as compared to their budgets and review transactions that occur in the general ledger.  They create journal entries to make corrections to their accounts in the general ledger.  Various custom and standard reports are available within Oracle to assist departments with these tasks. Access to the RIT Journal Entry and Reporting & Inquiry responsibilities gives them the ability to create journal entries, and run reports in the Oracle Financial Applications.  The more advanced functionality allows them to use the tools in Excel, (copy, paste, drag, insert), to create journal entries more efficiently.  

Prerequisite:

This course assumes that you are an active Journal Entry, and Reporting & Inquiry user of the Oracle Financial Applications, and are familiar with the terminology and logging in process.  It is advantageous to have some experience with Excel spreadsheets and the basic Excel copy, drag and paste functions.
If, after taking this course, you have further questions about performing account inquiries or requesting and printing reports, please contact Accounting at ext. 5-2237, or send an e-mail to acctg@rit.edu.
Lesson 1: Creating Journal Entries using Excel
The Launch Journal Wizard function in your “RIT – GL – JOURNAL ENTRY ONLY” responsibility gives you the ability to create a journal entry template in Excel and upload it into the general ledger.  This allows you to use the copy, paste, and drag functionality of Excel to enter journal entry lines into the journal entry template.  
Objective: 

At the end of this lesson, you will be able to create and upload a journal entry from Excel into the RIT General Ledger Application.

Scenario

You are an employee in the College of Science, and have to create a journal entry to charge different departments for lab fees.   You plan to create a journal entry template in Excel and reuse it every month.
Directions:

· Log into the Oracle Applications.

· Click on your journal entry responsibility in your homepage, (this will be “RIT – GL – JOURNAL ENTRY ONLY” or “GL SUPERVISOR”).
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· On your homepage click on the “Launch Journal Wizard” function, (in your Navigator screen this function will be under the “Journals” menu in the “GL Supervisor” responsibility).
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· The “Document Parameters” screen will open, replacing your homepage.
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· In the “Layout” field select “RIT Actuals – Single” from the drop down list.
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· The “Content” field should be set to “None”.  Click the “Create Document” button.
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· A Security Information window may open at this time asking if you want to display “nonsecure” items.  Click the “Yes” button.
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· The “Document Parameters” screen will be replaced by an “Information” screen which tells you that a file will be downloaded to your desktop.
· A “File download – Security warning” window will open asking you if you want to open or save this WebADI.xls file.  Click on the “Open” button.
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· Excel will open and another “Security Warning” window will open asking you to disable or enable macros.  Click on the “Enable Macros” button.
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·  A “Download” window will open in Excel letting you know that your document is in the process of being created.  Once the Journal Entry template has finished downloading into Excel the message in the “Download” window will confirm that your document has created.  Click the “Close” button to close this window.
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· A blank Journal Entry template has been downloaded into Excel.  
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· All white cells in the template can be updated either by double clicking on the cell to access the List of Values or by typing the value directly into the cell.  
· Another way to access the List of Values is to click in the cell and then on the “Oracle” menu in the Excel Menu toolbar at the top of the page.  Select “List of Values” from the drop down menu.  
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· A “Search and Select” window will open displaying a list of values to select from.  Click on the select circle to the left of the value you want to enter into the cell and click on the “Select” button.   
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· The Header section of the template includes the fields listed below.  These are the same fields that are in the Journal Entry form in the Oracle Applications. Those in bold italics are required.
· Source – Journal sources identify the origin of journal entries.  Journals with the source “Manual” were created within the Oracle Applications.  The default source for a journal entry created using the Journal Wizard and uploaded from Excel is “Spreadsheet”.  There are other sources available for you to choose from in the List of Values. For this journal entry we will leave the source as “Spreadsheet”.
Note:   If you’re a current ADI user your source may default to your individual source.  This will continue to happen when you create journal entries in Web ADI.

· Category - Journal categories help differentiate journal entries by purpose or type, such as accrual, payments or receipts.  The default category is “Adjustment”.  For this journal entry we will be using the category “Chargebacks”, see picture above.
· Accounting Date – The Accounting date is entered in normal date format, (mm/dd/yyyy).  Enter the date within the period you want the journal entry to be posted.  For example, if you want the journal entry posted in June, and today’s date is July 3rd, enter an Accounting Date for the last day of June, 06/30/2008.
· Batch Name – The Batch Name follows the RIT batch naming convention, first 3 numbers of a user’s dept. number, followed by his/her initials, the month, day and the number of the batch for the day, (i.e.:  670SXD1215-01).  After the journal entry is uploaded into the general ledger, the source, balance type and request id are added to the batch name, (i.e.: 670SXD1215-01 Spreadsheet A 2442018).
· Batch Description – Information about the batch’s purpose should be entered in this field.  If left blank, this field will default to “Journal Import”, the source, and the request id number, (i.e.: Journal Import Spreadsheet 2442018:).
· Journal Name – More descriptive information can be entered in this field about the journal entry.  If left blank, this field will default to the category and currency, (i.e.: Adjustment USD).
· Journal Description – More descriptive information can be entered in this field about the journal entry.  If left blank, this field will default to “Journal Import” and the request id number, (i.e.: Journal Import 2442018:).
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· The body of the Journal Entry template includes the columns listed below.  Those in bold italics are required.
· Upload Flag – The upload flag is used to mark the journal entry lines that are to be uploaded into the general ledger.  The Journal Wizard will ignore any rows entered after 3 blank rows, even if they are flagged to be uploaded.  Normally the upload flag will automatically fill in upon entering an account number into the template.  You can manually enter an upload flag by clicking in the upload flag column and typing any character on your keyboard.
· Entity, Department, Object, Expense Category, Project and Program – These are the 6 segments that make up RIT’s 24 digit account combination.  Each segment has its own column and has to be entered separately.  To use the List of Values to select the segment values, double click on any of the segments’ cells and the “Enter Flexfield” window will open.  
· Click on the magnifying lens to the right of a segment’s field in the “Enter Flexfield” window to access the segment’s List of Values.  The “Search and Select” screen will display for the segment.  
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· To see an entire list of all the values for a segment, enter the wildcard character into the “Search Criteria” field and click on the “Go” button.  The entire list of values will display in groups of 10. 
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· To see the next group of 10 values click on the “Next 10” button in the lower right hand corner of the window.  You can also click on the drop down list of groups of 10 to scan through the list.   
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· If you know the first couple characters of the segment value, you can see a reduced list of values by using the wildcard character.  You know the Mechanical Engineering department number you want to enter starts with “632”.  Enter “632%” in the “Search Criteria” field and click on the “Go” button.  A reduced list of values starting with department number “63200” will display for you to choose from.
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· Once you find the value you want to enter click on the select circle to the left of the value you want to enter into the field and click on the “Select” button.
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· The segment field will fill in on “Enter Flexfields” window.  If you know some of the segment values, such as Project, but not all, you can enter those you do know and then click on the “Combinations” button.  Enter “90310” in the “OBJECT” field, and “00000” in the “PROJECT” field.  Click on the “Combinations” button to see which accounts currently exist. 
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· An “Accounting Flexfield” window will display a list of 24 digit account combinations to choose from.  Select the account you want to enter, click on the “Select” button, and the values are entered into the fields on the “Enter Flexfield” window.  
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· Click on the “Select” button and an information window will tell you if the account number is valid.
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· Click on the “Select” button again and the account number will fill in on the journal entry template in the Excel spreadsheet.  At the same time the upload flag will fill in automatically.  Press the tab key repeatedly to move your cursor to the “Debit” field.
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Note:  When you enter accounts using the Accounting Flexfield screen, the account combination is validated at the time you click on the “Select” button.  This doesn’t happen if you manually type or paste the account numbers into the journal entry template.  In that case the accounts will be validated during the upload process.

· Debit, Credit – There can only be an amount in one of these columns per row.  If there are amounts in the debit and the credit column on the same row, an error will display after you attempt to upload it into the general ledger.  Enter $42 into the debit column and tab to the “Line Description” column.
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· Line Description – More descriptive information can be entered in this field about the journal line.  If left blank, this field will default to “Journal Import” after it has been uploaded into the general ledger.
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Note:  To automatically widen the width of the “Line Description” column to the right width, select the column, click on the “Format” menu, click on “Column” and select “Autofit Selection” from the drop down menu. 
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· Messages – This section is filled in by the Journal Wizard after an upload attempt has been made.  If an account combination is invalid or the journal entry is out of balance a sad face and an error message will display.  If the upload process was successful, a happy face will display next to each account combination.  This will be gone over in more detail later in the training.
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· Rows can be added to the journal entry template by using the Excel “Insert” function.  Select the number of rows you want to insert into the body of the journal entry.  Right click on the selection and select “Insert” from the drop down menu.  The rows will automatically insert into the template.
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· Journal entry lines can be copied and pasted into the template from another spreadsheet.  All the tools and functions that are available in Excel can be used to enter data into the template.  
· Clear the data that you have already entered in your journal entry template. 
· Open the “COS Lab Fees Nov-07” workbook open on your desktop.
· Select the information you want to copy and paste into the template, right click and select “Copy” from the drop down menu.
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· Click on the first cell in the “Entity” column, right click and select “Paste” or “Paste Special” from the drop down menu.
· When pasting formulas paste values into the cells use the “Paste Special” function from the drop down menu, otherwise it could cause the journal entry to be out of balance.
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· The information should paste into the template, saving you the time of entering the data manually.  The Upload Flag will automatically fill in.
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Tip: This is ot the end of the Template. Unprotect the sheet and insert as many rows as needed,




· Once all the journal entry lines have been entered into the template, it can be uploaded into the general ledger.
· Click on the “Oracle” menu in the Excel Menu toolbar at the top of the page.  Click on “Upload” from the drop down menu.
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· A “Journals Upload” window opens showing the following parameters, which automatically default to the correct settings:
· Rows to Upload – Should always be set to “Flagged Rows”.
· Automatically Submit Journal Import – Should always be checked.
· Create Summary Journals – Should never be checked.
· Upload Unbalanced Journals – Should never be checked.
· Descriptive Flexfields – Should always be set to “Do Not Import”.
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· Click on the “Upload” button.  A “Journals Upload” window displays showing the progress of the upload process.  
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· If any of the data has been entered incorrectly, (the account combinations don’t exist or are disabled in the general ledger), a message will display in the “Journals Upload” window stating that the upload process has completed with errors.  It should list out how many rows were invalid, if any of the information in the header section is invalid, and that no rows were uploaded.  
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· Click on the “Close” button and return to the journal entry template in Excel.  In the message section you will see a sad face and an error message next to the invalid combinations.  At this time your instructor will make the necessary corrections to the account combinations or header information.  When this is complete try the upload process again.  
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Note:  If you’re not sure how to fix an account combination error contact Accounting at ext. 5-2237.

· Once the upload process completes successfully the “Journals Upload” window will display a message listing out how many rows were successfully uploaded and provide a Journal Import Request ID number.  The Journal Import process will start automatically and can be monitored using this request id number.
· Click on the “Close” button to close the “Journals Upload” window.
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· Click on the “Oracle” menu and select “Monitor” from the drop down menu.  The “Monitor Requests” window will open showing the journal import process that was just started, with a phase of “Pending” in the first row.  
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· By clicking the “Refresh” button in the lower left hand corner of the window you can watch the phase change to “Running” and eventually to “Completed”.  
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· Click the “Close” button to close the “Monitor Requests” window.
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· To confirm that the journal entry imported into the general ledger successfully, you should view the Journal Import Execution report for this request.  Open the “View” menu in the Oracle Applications and select “Requests” from the drop down button.  
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· With “All My Requests” highlighted in the “Find Requests” form, click on the “Find” button.
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· In the “Requests” form, select the Request ID for the Journal Import Request and click on the “View Output” button.
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· The first section of the “Journal Import Execution Report” shows if the journal entry imported successfully or if it errored out due to being out of balance, or flexfield, (account), errors.
· The other sections on this report list out the batch information, provide information on an out of balance journal entry, and provide error messages for invalid account combinations.
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· The Journal Entry template can now be saved and used again as often as needed.  In Excel, click on the “File” menu and select “Save As” from the drop down menu.
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· In the “Save As” window that opens, select “Desktop” in the “Save in” field, add the date to the file name “COS Lab Fees Nov-07 and click on the “Save” button.  Close the Excel workbook.
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· This journal entry template can now be reused as often as necessary.  The next time you open the journal entry template a “Microsoft Excel” window will open and ask you if you want to disable macros, enable macros or want more information.  Double click on the “COS Lab Fees Nov-07” icon that you just saved to your desktop.  Click on the “Enable Macros” button to enable the Journal Wizard Macros.  
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· It is not necessary to be logged into the Oracle Applications in order open the template and upload the journal entry into the general ledger.
· After the journal entry has been imported into the general ledger, you can open the journal entry in the Oracle Applications, and make changes to it if needed.
· If it is necessary to send in back up for a journal entry, the spreadsheet can be printed and sent in to Accounting with the back up documentation.
· To create a copy of a journal entry template in the same Excel workbook:
1. Click on the “Edit” menu.
2. Select “Move or Copy Sheet…” from drop down menu.
3. A “Move or Copy” window will open.  Click the “Create a copy” box and click the “OK” button.
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· Notes to users of the release 11i version of client ADI:  
· The template no longer errors out with a runtime error if there are spaces in the file name.
Lesson 2: Account Analysis & Drilldown 

The Account Analysis function permits you to call up and view actual, budget, and encumbrance transaction detail for any of your 24-digit accounts.  Transaction detail is available to you on-line as soon as transactions are posted to the general ledger.  With the Drilldown function you can drilldown into the AP and AR subledgers and view subledger information for a transaction.
Objective: 

At the end of this lesson, you will be able to run an Account Analysis online, export the detail to Excel and drilldown into a subledger for a specific transaction.
Scenario

You are an employee of the College of Science.  You want to view the transaction detail for your operating department account for the first quarter of the fiscal year.
Directions: 

· Log into the Oracle Applications.

· Click on your reporting and inquiry responsibility in your homepage, RIT – GL – COS RPT & INQ – 67000-67099.
· On your homepage click on the “Account Analysis & Drilldown” function, (in your Navigator screen this function will be under the “Inquiry” menu in the “GL Supervisor” responsibility).
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· The “Account Balances” screen will replace your homepage in the browser window.
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· The “Inquiry Type” field will change your display from seeing one period at a time to a range of periods.  For this exercise select “Period Trend” from the drop down list.  Notice that the display at the bottom of the screen now shows multiple “PTD” and “YTD” columns.
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· The “Ledger/Ledger Set” field remains “RIT”.  
· Click in the “Account From” field.  You can enter a range of account numbers by either typing in the 24 digit account combinations directly into the “Account From” and “Account To” fields, or you can click on the magnifying lens and use the “Search and Select” window to query up possible account combinations to choose from.  
· Click on the magnifying lens to the right of the “Account From” field. 
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· In the “Search and Select: Account From” screen, click on the magnifying lens to the right of the “Department” segment field to access a list of values.  
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· In the “Search and Select: DEPARTMENT” screen enter “67%” in the “Search By” field and click on the “Go” button.
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· To start your account range with department select “67000”, click on the circle in the “Select” column to the left of department “67000” and click on the “Select button.
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· Back in the “Search and Select: Account From” screen, enter “00000” in the “PROJECT” field and click on the “Search” button.
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· In the “Results” section of the screen a list of account combinations that use dept. “67000” and project “00000”will display.  Select the account combination “01.67000.73005.25.00000.00000” to start your account range and click on the “Select” button.
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· Back in the “Account Balances” screen the “Account From” field has filled in.  Press the Tab key to go to the “Account To” field and click on the magnifying lens button to the right of this field.
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· Repeat the process to select account combination “01.67000.90385.25.00000.00000”, the account you want to end with in the “Account To” field. 

· Press the Tab key to go the “Balance Type” field.

· The “Balance Type” field defaults to “Actual”.  If you were trying to run an Account Analysis for a Budget or Encumbrance activity, you would select “Budget” or “Encumbrance” from the drop down list.  
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· Press the Tab key to go to the “Currency” field.
· The “Currency” field defaults to “Total”.  You can either leave it on “Total” or change it to “Entered”, the results will be the same since there is no statistical data in the general ledger. 
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· Press the Tab key to go to the “Period From” field.

· To choose a period from the LOV, click on the magnifying lens to the right of the “Period From” field.  This will open a “Search and Select: Period From” window.  
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· Enter the wildcard character, (%), to view a list of all the periods available. If you want to see a list of periods for only one year enter the last 2 digits of the year after the wildcard and click on the “Go” button.  You enter “%07” to get a list of all the periods in FY 2007.
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· Select the “JUL-07” period and click on the “Select” button.  Press the Tab key twice to enter the “Period To” field and repeat the process to choose “SEP-07”.
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· Press the Tab key twice to go the “Display Summary Accounts” field.  RIT doesn’t use summary accounts so the “Display Summary Accounts” field should always be “No”.  Press the Tab key to go to the “Display Accounts with No Activity” field.

· The “Display Accounts with No Activity” defaults to “Yes”.  If you want accounts without activity not to display on your report, select “No” from the drop down list and press the Tab key to go to the “Go” button.
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· To start the search for the transaction detail for the range of account numbers and periods you selected, click on the “Go” button.
[image: image69.png]Account Balances
* Indicates required field

Tnuiry Type [Period Trend =)

Note that the search is case insensitive

* LedgerLedger Set [RIT Q * Period From  [1UL-07 Q

Ledger Currency * Period To_[5EP-07 Q
Account From  [01.67000.73005.25.00000.00000 | o, Dieplay Summary Accounts [o [

ENTITY.DEPARTHENT.OBECT EXPENSE
CATEGORY PROJECT PROGRAM Display Accounts With No Activity [No ]

* Account To ~[11.67000,90385,25,00000,00000

ENTITY DEPARTMENT OBJECT EXPENSE.
CATEGORY PROJECT PROGRAM

Balance Type [actual <!
currency Type [Total

@TIP For exnlanation of cur!vcv codes Leed in His nace. see e currency ke

H

J:




· The bottom half of the screen will display the PTD and YTD account balances for each account combination for each period.
[image: image70.png]Balance Type [actual <!

currency Type [Toal =
Go | [ clear

“TIP For explanation of currency codes used in this page, see the currency key.

Export < previous [110_ 7] Mext 10 ®

PID )
Ledger - |account currency ‘ w07 AUG-07 SEP-07  JUL-07 AUG-07 SEP-07  Summary Accounts
RIT 01.67000,73150.25,00000,00000 UsD 24117 111523 843263 341117 452640 1301903
RIT 01.67000.73151.25.00000,00000 =) us7s 0.00 L2636 11575 11575 24271
RIT 01.67000,73159.25.00000,00000 usD 052603 565164 (1550064) 992609 1557773 (@1291)
RIT 01,67000.73250.25.00000.00000 usD (588.36) 588.36 0.00 (588.36) 0.00; 0,00
RIT 01.67000,73253.25.00000,00000 usD 139100 955.04 379479 139100 2,346.04 6,140.83
RIT 01.67000,73350.25.,00000,00000 usD 512619 19345 215097 512619 706264 1022261
RIT 01.67000,73351.25,00000,00000 usD s78.08 7587 494,27 57808 653.95 114822
RIT 01.67000.73600.25.00000,00000 =) 000 000 000 a0 0.00 0m
RIT 01.67000,73750.25.00000,00000 usD 000 000 34133 .00 0.00 34133
RIT (01.67000,74200.25.00000,00000 usD [ 25000 0.00 0.00 250,00, 25000

Export < previous [T10_ ] Next 10 ®




· Click on the “Export” button to download the account balance information into an Excel spreadsheet.
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· A file download window will open asking if you want to open or save this file.  Click on the “Open” button.
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· If Excel isn’t open already, a new Excel window will open and the detail will be downloaded into a new spreadsheet named export[1].
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NOTE:  It is good practice to save this spreadsheet at this time and rename the workbook.  If you try to export again it will try to create another workbook with the same name and won’t be able to export until the first workbook is closed or renamed.

· Back in the “Account Balances” screen, the amounts in the “PTD” column are colored blue and are underlined to show that you can drilldown into them.  Click the “Next 10” button and click on the “939.65” in the “PTD” section for period “AUG-07”, for account “01.67000.76950.25.00000.00000”.  This will drilldown into the “Journal Lines” screen which provides the batch name, journal name, line number, source, category, currency, debit and credit detail.  
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· In the “Journal Lines: 01.67000.76950.25.00000.00000, AUG-07” screen, click on the “Export” button to download the journal line detail into Excel.
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· On this screen the amounts in the debit and credit columns can be drilled down into, to view the subledger detail for each AP or AR transaction.  Click on the “566.98” amount to drilldown into the “View Journal Entry Lines” screen.
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· To examine a specific invoice in the “View Journal Entry Lines” screen, click on the circle in the “Select” column in the row containing the amount you want to drilldown into.
· Click on the “View Journal Entry” button to view the journal entry.  The “Subledger Journal Entry” screen opens.
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· The “Transaction Information” section includes subledger information:

· Party Name

· Invoice Number

· Invoice Type

· Party Site Name

· Invoice Amount

· Invoice Date

· Invoice Description
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· The “Lines” section shows the account number and the offset account. 
· In the “Detail” column, the “Show” link provides Third Party, Description, Currency and General Ledger information.
· To return to the Journal Entry Lines screen, click on the “Return to Subledger Journal Entry Lines” button.

· Click on the “Home” button to return to your home page.

· Click on the “Export” button to export the Subledger Journal details into Excel.
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· Back in the “View Journal Entry Lines”, click on the “Export” button to export the subledger details on this screen to Excel.

· Click on the “View Transaction” button to view the “Invoice Workbench” screen within the Oracle Applications.  
[image: image80.png]View Journal Entry Lines

Ledger RIT GLBatch Name 22873 Payables 2122006: A 50555
Feriod  AUG-07 GL Journal Entry Name  Purchase Invoices USD

Currency USD Accounted DR 566.98

Account 01.67000.76950.25.00000.00000 Accounted CR

AdvancedSearch

Specify pararmeters and values to filter the data that is displayed in your results set.
@ Show table data when all conditions are met,
€ Show table data when any condition is met.

e [ 3] [ Q
sabncing Segrrent [ G
Natural Account Segment— [ic =
aose o 3 [ B
Go || Clear |add another [accounted CR =] | Add
Select Subledger Journal Entry Line: | View Transa:liu\pbj [ view Journal Entry | | [ Export |
Select Ledger ~ |lAccount. |6L Date |Accounting Class | Accounted DR|
& R 01,67000.76950,25.00000,00000 01-Aug2007  ltem Expense 36404

c R 01.67000,76950.25.00000,00000 012007 ltem Expense 20294




· Your browser window will change to an Oracle e-businesssuite window.  Do not close this screen if you want to go back and perform more drilldowns.  Instead minimize the screen to view the “Invoice Workbench” in the Oracle Applications.
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· The “Invoice Workbench” screen provides you with transaction details such as Supplier, PO number, and Invoice number. 
· In the upper section of this screen you can see the Supplier name, Supplier number, Supplier Site, Invoice date and the Invoice number.  
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· In the lower section of the “Invoice Workbench” screen there are six tabs that provide Invoice, Purchase Order and Payment information.  
[image: image83.png]1 General

Summary

4View Payments | & Scheduled Payments | B View Prepayment Applications

tems [ 364.04

Retainage [
Prepayments Applied [
Withhelding [
Subtotal [ 3404
T

Freight [
Miscellaneous [

Tool [ saos

[usD [384.04

Status [Validated

Accounted [Yes

Approval [Not Required
Halds [0

Scheduled Payment Holds |0

Description

BASE CHARGE AUGUST




· Click on the “Lines” tab to see the Purchase order number, scroll to the right to see the item description.
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· Click on the “View Payments” tab and then the “Payments Overview” button.  From the “Payments Overview” screen you can see whether the check has cleared the bank and on what date.
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· To return to the Account Inquiry screen from the Payable’s screens, click on the Close box in the upper right corner of each screen.
When you clicked on the “View Transaction” button to view the Invoice Workbench, you were taken out of the browser window and into the Oracle Applications.  The “View Journal Entry Lines” browser screen changed to an Oracle e-business suite screen.  
· To return to the “View Journal Entry Lines” browser screen and view the transaction information again, click on the “Back” button.
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· This will take you to a “Warning: Page has Expired” screen.  Click the “Refresh” button.
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· A “Microsoft Internet Explorer” window will open and ask you if you want to retry sending the information again.  Click on the “Retry” button.
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· You are now back in the “View Journal Entry Lines” screen.  

· To return to the “Journal Lines: 01.67000.76950.25.00000.00000, AUG-07” screen click the “Journal Lines” link in the upper left section of the page.  
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· You are now back in the “Journal Lines” screen.  To return to the “Account Balances” screen, click on the “Return to Account Balances” link in the lower left corner of the page.
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· At any time you can close out of the “Account Analysis and Drilldown” process by clicking on the “Close Window” link at the bottom of the page.
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Lesson 3:   Downloading RIT Account Analysis Reports into Excel
In the last lesson you learned how to access the Account Analysis detail and export it to Excel through the Account Analysis function.  Another way to get this information into Excel is to run a standard detail report within the Oracle Applications, download the report and format it in Excel using the Microsoft Text Import Wizard.

Objective: 

At the end of this lesson, you will be able to download an Account Analysis report into Excel and format the data.

Scenario

You are an employee in the College of Science.  You have received a request from the Dean for a summary of all the travel expenses for the College of Science for the first quarter of the fiscal year.  You need to load all the travel expense detail from the general ledger, into Excel in order to create a summary report.
Directions:

· Log into the Oracle Applications.

· Click on your reporting and inquiry responsibility in your homepage, RIT – GL – COS RPT & INQ – 67000-67099.

· Click on “Reports” in the list of functions to the right of your responsibility list in your homepage.
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· The Oracle Applications will open, displaying the “Submit a New Request” form with “Single Request” selected.  Click on the “OK” button.
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· The “Submit Request” form will open. In the “Name” field type “RIT Acc” and hit the tab key.  The “RIT Account Analysis-(180 Char)” report name will fill the field, and the “Parameters” window will open.
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· Enter “JUL-07” in the “Starting Period field, and “SEP-07” in the “Ending Period” field.
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· Enter “01.67000.78000.25.00000.00000” in the “Flexfield From” field, and “01.67000.78999.25.00000.00000” in the “Flexfield To” field. Click on the “OK” button.
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· Back in the “Submit Request” form, click on the “Submit” button.
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· The “Requests” form will open.  Once the report request completes click on the “View Output” button.
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· The report will open in a new browser window.  Under the “File” menu click on “Save as” and save the report as a text document called “COS Travel Q1 exp”.
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· Open the report in Excel.  The Text Import Wizard will open. 
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· Click on “Fixed Width” for the column settings, and then click on the “Next” button.
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· Step 2 of 3 determines how the data is divided up into columns. Scroll down until you are viewing the column headers with the header underlines, and the first line of data.  Click once to set up a column border.  To move a border click on the line, hold your mouse button down, and drag the line to where you want it.  In order to delete a border, double click on the line.  Be sure to scroll all the way to the right.  Once all the column borders are set click on the “Next” button.
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· Step 3 of the Text Import Wizard is to format certain columns in the “Text” format. All the columns, except for the Debit and Credit columns should be in the text format.  Select the columns you want to format as text. Click on “Text”, and then click on the “Finish” button.   
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· The next step in creating a spreadsheet is to sort the data.  Click on the left uppermost cell, the blank cell above the “1” and to the left of “A”, to select the whole spreadsheet.  Next select the “Data” Menu and choose “Sort”.  Select column “E” in order to sort the data by the 24-digit account combination.  Click on the “OK” button.
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· Delete the rows you don’t want to display, generally these are the ones that contain the page headers and underlines.  They do not contain the account combination, and financial data. As a result of the sort there are a group of these rows in the beginning and the rest will be at the end of the spreadsheet after the last row containing financial data.  Click on the row number where you want to begin deleting and drag up or down to include all the rows that need to be deleted.  Under the “Edit” Menu, select “Delete” to delete the rows. 
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· Use the Text to Columns wizard to divide up the account combination so that each segment value, (entity, dept, object, fec, project, and program), has its own column.  Insert 5 columns after the Account Combination column, (column E)
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· Select the Account Combination column, (column E), and under the Data” Menu, select the “Text to Columns” option.  
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· Check “Fixed Width”, and click on the “Next” button.
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· Place column borders to divide the segments up and separate the periods.  (See illustration below)  Click on the “Next” button.
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· All the segment value columns need to be in text format. Select the segment columns and click on the “Text” format.  Select the period columns and select “Do Not Import”.  Click on the “Finish” button.
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· Under your “File” menu select “Save As” and save your report with a “Microsoft Excel Workbook file type.  
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This spreadsheet can now be used to create other reports in Excel, or to reconcile your monthly department statement.  

Lesson 4:   Request Set Creation
You can use a Request Set to run all of your monthly reports at one time, such as your Department Statements, Project Statements and RIT Account Analysis reports.  A Request Set allows you to include all the reports you want to run in a set and then run the set instead of running each report individually.

Objective: 

At the end of this lesson, you will be able to create a Request Set to run all of your monthly statements and detail reports at one time.

Scenario

You are an employee in the College of Science.  You want to create a Request Set for your monthly department and project statements, and detail reports.  This will reduce the amount of time it takes for you to run your department’s reports each month.

Directions:

To create a Request Set select the “Other” menu in your Navigator screen and click on the “Open” button.
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Next select the “Requests” menu and click on the “Open” button.
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Select “Set” and click the “Open” button, the Request Set screen will open.
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In the Request Set screen click on the “Request Set Wizard” button.
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The first step of setting up a Request Set through the Request Set Wizard is to determine if you want your group of reports to run sequentially or parallel.

Sequentially – To run one after another.  This is generally used for programs and not reports.  One program can be dependant upon another, but your reports will not depend on each other for their values.

In Parallel – Since your reports are not dependant upon one another it is possible to run them all at the same time.

Select the “In Parallel” option by clicking on the circle to the left, and then the “Next >” button.
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In the next step enter a name for your Request Set in the “Name” field and tab to the “Application” field.
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· In the “Application” field type “General” and hit the tab key.  The Application name “General Ledger” will fill in the field.
· Enter a description of the Request Set in the “Description” field and click the “Next” button.
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You can choose whether you want the reports to print as each one completes or after all of them have completed.  Choose “As Each Request in the Set Completes”, and click the “Next” button.
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· In the last step of the Request Set Wizard you will select the reports you want to include in your Request Set.  
· Type “RIT” in the first row and hit the tab key.  The field will fill in with the “RIT Account Analysis-(180 Char)” report for your operating accounts detail.  Repeat this process in the second row for your project accounts detail.
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· For your FSG reports, such as your Department or Project statements, select the “Program – Run Financial Statement Generator” for each report you want to run.
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· When you are finished selecting your reports click on the “Finish” button.
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A Note window will open letting you know that your Request Set has been saved, click on the “OK” button.
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Your Request Set’s information will automatically fill in the Request Set screen.  Click on the “Define Stages” button.
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· In the “Stages” form click on the “Requests” button.
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In the “Stage Requests” screen select the row 10 with the “RIT Account Analysis-(180 Char) detail report and click on the “Parameters” button.
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· In the “Request Parameters” form the following changes can be made.

· Under the “Shared Parameter” column, in the “Starting Period” row type “Starting Period”.  In the same column, in the “Ending Period” row type “Ending Period”.  This will allow this parameter to be share with requests for this report in the same request set.

· In the “Flexfield From” row, under the “Type” column, select “Constant”, and enter “01.67000.70000.00.00000.00000” in the “Value” column.  In the “Flexfield To” row, select “Constant” in the “Type” column, and enter “01.67099.99999.99.00000.00000” in the “Value” column.  These are the lowest and highest accounts you want to get detail for in the report.
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· Save your changes and close the Request Parameters screen.  Back in the Stage Requests screen select the next row for the “RIT Account Analysis–(180 Char)” and click the “Parameters” button.
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· Repeat steps 18-23 only this time in the “Flexfield From” and “Flexfield To” rows in the “Value” column enter the lowest and highest account numbers you want detail for, for your project accounts, “01.67000.70000.00.10000.00000” to “01.67099.99999.99.99999.00000”.
· In the “Report By” row, change “Department” to “Project” so this report sorts by project instead of department.

[image: image133.png]© Request Parameters

Set Application

Sequence  EANND

Application (S

Display Shared Defaul
Seq Madify Parameter Type Value
| n
1Em C
{[s | @
1= @
1= @
1EN @
{110 ] @
{10 ] @
1EN @
[ |
[ CRNC
e | e




· In the Stage Requests screen select the first row for the “Program – Run Financial Statement Generator” and click the “Parameters” button.
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· In the “Report” row in the “Type” column select “Constant” from the list of values.  In the “Value” column enter “RIT- Dept Statement”.
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· In the “Period” field in the “Shared Parameter” column enter “Period”, and clear the values in the “Type” and “Value” columns.
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· Save your changes and return to the Stage Requests screen.  Continue to select each row with “Program – Run Financial Statement Generator” and enter the parameters as above.  The other 2 FSG reports that SDOE included are:

· SPA GRANTS STATEMENT

· OTHER PROJECTS STMT
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NOTE:  You must enter the Report name in the “Value” column exactly as it appears in Oracle.

· Once you are finished entering the parameters for each report you are finished and ready to run your request set.  To do this return to your Navigator screen and open “Reports”.
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· When the Submit a New Request screen opens select “Request Set” and click the “OK” button.
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· In the Submit Request Set screen select the name of your Request Set from the list of values in the “Request Set” field.  
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· Next click in the “Parameters” field for the first report.  The Parameters screen will open.  
· For the Account Analysis reports enter the Starting Period and Ending Period you want to run these reports for and click on the “OK” button.  You only have to enter the period in these fields in the first report, it will automatically fill in for the rest of the Account Analysis reports.
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· If you click in the rest of the Account Analysis reports’ parameter fields you will see that the Starting and Ending Period fields has automatically filled in, but you don’t have to click in the rest of the parameter fields.

· When you click the “OK” button you will be taken back to the Submit Request Set screen and into the next field which is “Language”.  If you want to specify printing and report notification options you will want to click on the “Options” button at this time if not scroll to the left to see the Program names again.
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· Next click in the first “Program – Run Financial Statement Generator” parameter field and enter the period.  This period is shared by the other FSG reports that you are running so you do not need to enter this field for each report, just the first one.  This field automatically defaults to the current open period so in some cases you may not need to enter anything for the FSG reports.
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· Once you are finished entering the periods and printing options click on the “Submit” button to run your Request Set.
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· The Requests screen will open, once you have refreshed it at least once you will see that each report has its own request id, and are all running at once.  Once these reports complete they will be sent to the printer automatically.
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The “RIT Account Analysis – Subledger with AP” report can be run with a source of “Payables” to view the subledger detail for a range of accounts.  This report can be added to Request Sets also, but at this time cannot be sent to a networked printer.  In order to print this report, you must view the output in PDF, HTML or Excel format for each request in your Request Set, and print from using the print function in Adobe, your browser window or Excel.

First we have to add this report to our existing Request Set.

· In the Navigator screen navigate to Other / Requests / Set and click on the “Open” button.
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· Click on the Flashlight icon to query up the Request Set.
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· Select “COS Monthly Request Set” from the list that appears and click on the “OK” button.
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· In the “Request Set” screen, click on the “Define Stages” button.
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· In the “Stages” screen click on the “Requests” button to see the list of requests included in the Request Set.
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· In the “Stage Requests” screen enter the next sequence number in the next available row.  

· Type “RIT Account Analysis – s” in the “Program” field and press the Tab key.
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· The rest of the fields will automatically fill in.  To enter the parameters for this report click on the “Parameters” button.  The “Printer” field does not need to be filled in since this report cannot be printed from a network printer.
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· Enter “Period From” in the “Shared Parameter” column for the “Period From” row, and “Period To” in the “Period To” row, in order to share these fields with other requests for this report in the same Request Set.
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· In the “Account Flexfield From” and “Account Flexfield To” fields enter “Constant” in the “Type” column and the account number ranges in the “Value” column.
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· In the “First order by”, “Second order by” and “Third order by” you can change the “Value” column to be “Department”, “Project”, or “Object”.

[image: image157.png]© Request Parameters £ 71X

Set Application

Sequence FUND

Display Shared
Moy Parameter
o

KNS

and order by subtot;

L IN<NSR]

{
1
1
1
1
1
1
1
1
1
1
1

<}





· Save your changes and close the screens to return to the Navigator screen.
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· You can now request your Request Set like you normally would.  
· In the “Submit Request Set” screen click on the “Options” button to change the format of the report to HTML or Excel.  The preferred output for printing is PDF which is the default.  You don’t have to make any changes if you want to leave the report in the PDF format.
[image: image159.png]© Submit Request Set
Run this Request.

Reguest Set

Program Operating Uit Stage Parameters
R
| |Program - Run Financia
| |Program -
| |Program -

At these Times.

T




[image: image160.png]© Upon Completion. E3

iSave all Output Files
Layout
Template Name Template Language

RIT Subledger ACCT
i T
1 I S R

For Language
TERICAN

Notify the following peaple

Narne For Language

[ I
1 I B

I
i

Print the Output To
Style
Printer Copies For Language

Wocto2ae 0 |
i 71
- T 71
1 I R B

GEmE 4 @G T




· Click on the Submit button, and open the View / Requests screen.  Once the request completes click on the “View Output” button.
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· Click on the Printer button to send the report to a local printer.
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· Select a printer name and click the “OK” button.
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The last 3 steps will have to be followed for each “RIT Account Analysis – Subledger with AP” request that is included in your Request Set.

This concludes the Advanced Financial Applications training.  If you have any questions please contact Accounting at ext. 5-2237.
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